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Notes and cautions

The following notes and cautions apply to
ElixiGraphics.

ATM  outline font support

ElixiFont now supports ATM outline fonts.

System display colors

If you experience memory problems while editing im-
ages, first check your system information by selecting
[System Info] from the System menu.  The System In-
formation dialog box displays with information about
the currently loaded file. 

The  value  listed for "Number of colors" in this dialog
box refers to the number of colors your monitor is set
to display.  To resolve any memory problems, you can
change your setup to display 16 colors.  If your display
is already set for 16 colors, you should increase the
amount of RAM on your PC.

Image size

New image sizes are now available when creating a
new image:  Legal, 11 x 17 inches, A3, and Other
(custom sizes).



Elixir HP driver

The Elixir HP driver is no longer available when proof
printing from ElixiGraphics.  You can proof print using
your Windows HP PCL or PostScript driver, however.
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1.  Introduction

ElixiGraphics is a full-feature, Windows-based, bitmap
editor that allows you to create and edit Elixir-format
graphics.

Depending on the toolset you selected in the ElixiSys
Desktop, ElixiGraphics allows you to edit or create
black-and-white, highlight color, and full-color Elixir-
format graphics. 

ElixiGraphics provides the environment and drawing
tools normally found on dedicated graphics
workstations. 

Combined with the ElixiSys Desktop (described in the
"ElixiGraphics environment" section of this chapter),
ElixiGraphics provides powerful features to support
your Xerox high-speed laser printing systems.

If you are familiar with GEM versions of ElixiGraphics,
you will find the Windows-based version contains the
functionality of the GEM versions plus added features,
including a new interface.  If you have never used
ElixiGraphics before, you will find ElixiGraphics highly
intuitive and easy to use.

Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

If you have purchased your Elixir product directly
from Xerox Corporation then you should contact
the Xerox customer support center telephone
number provided by Xerox.
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If you have purchased your Elixir product directly
from Elixir Technologies then contact one of the
support center hotlines.

See the Elixir Getting Started Guide for information
about contacting your support center.

          ElixiGraphics environment

ElixiGraphics is designed to work with the ElixiSys
Desktop, a Windows-based desktop.  The ElixiSys
Desktop simplifies file conversions and management
by presenting the user with icons which can be ma-
nipulated with simple mouse drag-and-drop tech-
niques (refer to the  ElixiSys Desktop User Guide for
more information).

Other Elixir products that you can use with the Elixi-
Sys Desktop are:

ElixiForm, which is a Windows-based WYSIWYG
forms creation package that creates boilerplate
forms for conversion to Xerox-format source or
object data streams. Graphics files created with
ElixiGraphics can be used on ElixiForm forms.

ElixiFont, a sophisticated Windows-based font
editor that you can use to create or edit Elixir-
format fonts which you can then convert to Xerox
and other format fonts.  Black-and-white graphics
files created with ElixiGraphics can be converted
to Elixir fonts by tiling them so that each tile repre-
sents a character in the font.

This guide is intended for users familiar with Xerox
graphics resources.

Knowledge of Windows and DOS, especially naviga-
tion through directory and subdirectory structures and
file operations is also required.

INTRODUCTION
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Who should use this guide

This guide is intended for users familiar with Xerox
graphics resources.

Knowledge of Windows and DOS, especially naviga-
tion through directory and subdirectory structures and
file operations is also required.

Conventions

This section describes the display and typographical
conventions.

Display conventions

ElixiGraphics adheres to Microsoft Windows conven-
tions for using menus, menu commands, dialog
boxes, command buttons, icons and a mouse.  See
your Windows manual for more information. 

Typographical conventions

The following typographical conventions are used
throughout this guide: 

Keystrokes are shown enclosed in <  > (angle
brackets).  For example, <Enter>.

Key combinations are denoted by a plus sign be-
tween keys.  For example, <Shift> + <F1> indi-
cates to simultaneously press the <Shift> and the
<F1> keys. 

Menu titles are shown in bold.  Menu options are
enclosed in [ ] (square brackets).  For example,

Pull down the File menu and select [Load].

INTRODUCTION
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Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected characters.

Steps in a procedure are shown in numbered bold
paragraphs.  For example

1. Pull down the Window menu and select [Tile].

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

On-line help

ElixiGraphics uses the Microsoft Windows Help pro-
gram to provide on-line help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with ElixiGraphics include
graphics which were created using screen drivers with
large fonts.  If you use a screen driver with small
fonts, the Help file graphics may not display clearly.
For optimum graphics display, use a screen driver that
uses large fonts. 

You can display on-line help in the following ways:

Bubble help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.

INTRODUCTION
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Quick help
Enable the quick help function by selecting the [Show
Quick Help] option in the Preferences dialog box.
When you move the screen pointer over and icon on
the screen, a short description of the icon function dis-
plays in the Message area of the screen.  During cer-
tain operations a message about the function you are
performing also displays in the Message area.  You
can disable quick help if you prefer to see these op-
erational messages.

Context sensitive Help
To use this function, press <F1>.  The Help table of
contents displays.

Help menu
Select [Help] from the ElixiGraphics menu bar and se-
lect one of  the displayed topics.

Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.  

Help Hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps.  Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), Toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu.

INTRODUCTION
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Organization of this Guide

This User Guide is organized as follows:

Chapter 1, "Introduction," is a brief overview of Elixi-
Graphics software and documentation. 

Chapter 2, "ElixiGraphics basics," describes how Elixi-
Graphics fits in with your Xerox printing system and
with other Elixir products. Basic information required
for using ElixiGraphics to create an image is de-
scribed in this chapter along with pointers to other
chapters and appendices for additional information.

Chapter 3, "Displaying and drawing an image," de-
scribes how a loaded image displays at various mag-
nifications, how large images are displayed, and how
to use the drawing tools displayed at the left of the
ElixiGraphics screen.

Chapter 4, "Manipulating images and image areas,"
describes operations you can perform on the entire
image or on marked areas in an image.

Chapter 5, "Using text and clip art," describes how you
can bring in text from fonts and how to create fonts
from images (by tiling the image) or image portions
(by cutting areas into a font). The concept of "clip art",
Elixir-format fonts containing image portions, is intro-
duced in this chapter.

Chapter 6, "Additional features," contains descriptions
of features that are not directly related to drawing im-
ages but are included as supports for using Elixi-
Graphics (for example, ruler and grid display and
merging images).

Appendix A, "Working with highlight colors," describes
how to use the highlight color features of ElixiGraphics
(for HighLight Plus, or Option users only).

Appendix B, "Keyboard shortcuts," lists keyboard
shortcuts for ElixiGraphics operations.

Appendix C, "DOS directories," lists the directories
used in ElixiGraphics operations.

INTRODUCTION
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Appendix D, "Conversion chart," contains a chart
showing supported formats for Graphics conversions.

Glossary

Index

Starting ElixiGraphics

To start ElixiGraphics from the Elixir Desktop:

Open (double-click on) the ElixiGraphics icon at the
right of the Desktop. 

The ElixiGraphics window (shown in the following fig-
ure) displays.

Figure 1-1. ElixiGraphics window

INTRODUCTION
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Alternatively, with the Elixir Desktop displayed, open
the Graphics folder, then open the Elixir Graphics
folder and double click on a graphics file. The Elixi-
Graphics window (shown above) displays with the
graphics file loaded and displayed at the center of the
screen.

Exiting ElixiGraphics

To exit ElixiGraphics, pull down the File menu and se-
lect [Exit] (or press <Alt> + <X>, or <Alt> + <F4>), or
double-click on the Close button.

INTRODUCTION
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2.  ElixiGraphics basics

This chapter presents an overview of ElixiGraphics
and brief instructions on how to use it.  This chapter
also includes references to other chapters in this user
guide that include detailed information.

Overview

PC-based graphics packages can create and edit im-
ages in two ways: in bit-mapped format where all
graphics elements created are stored as a collection
of dots, or in vector format where image elements are
stored mathematically.  ElixiGraphics edits images in
bit-mapped format. 

Other PC-based bitmap graphics formats include
Xerox IMG and LGO, PCX, BMP, and TIFF.

Converters in the Elixir Desktop enable you to import
LGO, IMG, PCX, BMP, and TIFF images and convert
them to Elixir format.  When in Elixir format, you can
use ElixiGraphics to edit the images.  Afterwards, you
can reconvert your edited images back to the original
format or to Xerox LGO, IMG, PCX, BMP, TIFF, or
Elixir font formats (see the following figure).

     Figure 2-1.  Importing/exporting ElixiGraphics images

FONT

FONT

 IMG LGO PCX/TIFF/BMP

ELIXIGRAPHICS

IMG LGO PCX/TIFF/BMP
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See the ElixiSys Desktop User Guide for more infor-
mation about converting files.

ElixiGraphics and other Elixir products

The Elixir Suite for Xerox products are designed to in-
terconnect.  The following paragraphs describe exam-
ples of this interconnectivity.

Any scanner that generates PCX or TIFF (Group 4)
formats can be used from the Elixir Desktop.  The
Elixir Desktop can then convert the files to Elixir for-
mat for use in ElixiGraphics.

ElixiGraphics enables you to create fonts directly from
graphics by tiling the graphic into equal rectangles,
each of which corresponds to a character in the font
(see the "Using text and clip art" chapter).  These
fonts can be imported and edited in ElixiFont and then
converted to Xerox format and printed on any Xerox
printer.

You can use the Elixir Desktop to convert a Xerox font
into Elixir format, and then import the font and place it
in an image using ElixiGraphics.

A powerful feature of ElixiGraphics is the inclusion of
clip art libraries which are managed by ElixiFont and
used in large graphics projects (see the "Using text
and clip art" chapter).

Graphics created using ElixiGraphics can be used in
ElixiForm to enhance the appearance of a form.  You
can use ElixiGraphics to copy forms from other
sources as follows: You can scan an existing paper
form into an image file (for example, PCX or TIFF),
convert the image to Elixir format, and use the Elixir
graphic as a template in ElixiForm to be traced over to
create a new Elixir form (see the "Additional features"
chapter).

ELIXIGRAPHICS BASICS
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ElixiGraphics features

The ElixiGraphics window is shown in the following
figure.  A blank Work area displays at the center. The
Work area menu bar displays above the Work area,
and the ElixiGraphics menu bar displays at the top of
the screen.  The ElixiGraphics window also displays a
Toolbox, and Toolbar.  The menu bars, Toolbox, and
Toolbar are described in the following sections.

Figure 2-2.  ElixiGraphics window

Overview of features

This section gives an overview of ElixiGraphics fea-
tures and refers you to the chapters where features
are explained in detail.

ELIXIGRAPHICS BASICS
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Menu bars

The ElixiGraphics menu bar contains the following
menus:

System
The options in this menu allow you to configure Elixi-
Graphics, as described in the "Configuring the sys-
tem" section of this chapter.

Window
The options in this menu allow you to use the Micro-
soft Windows Multiple Document Interface (see the
"Loading an existing image" section of this chapter, or
your Microsoft Windows User's Guide for details), and
to toggle between displaying and hiding the Toolbox
(see the "Toolbox" section of this chapter).

Help
This menu allows you to access the on-line help fea-
tures described in the "Introduction" chapter. 

The Work area menu bar contains the following
menus:

File
The options in this menu allow you to load, create,
print, and save images, and exit ElixiGraphics.  In ad-
dition, there are options for merging an image into an
existing image, resetting an image to the last save
state, and saving an image area.  File menu opera-
tions are described in this chapter, the "Manipulating
images and image areas" chapter, and the "Additional
features" chapter.

Edit
The options in this menu allow you to cut and paste to
the Windows clipboard, copy a screen area, and de-
lete all drawings in an image area.  In addition, this
menu contains the undo and redo features described
in the "Toolbar" section of this chapter.  Edit menu op-
erations are described in the "Manipulating images
and image areas" chapter.

ELIXIGRAPHICS BASICS

2-4 ELIXIGRAPHICS USER GUIDE



Image
The options in this menu allow you to view image at-
tributes, expand or contract an image, set the stretch
mode when reducing images, and refresh the screen.
In addition, this menu allows you to access the Extra
Operations sub-menu which is described in the "Ad-
ditional features" chapter.  Image menu operations
are described in this chapter, the "Manipulating im-
ages and image areas" chapter, and the "Additional
features" chapter.

Tool and Transform
These menus correspond to the Toolbox options de-
scribed in the "Toolbox" section of this chapter.

Toolbox

The following figure displays the ElixiGraphics toolbox.

Figure 2-3.  ElixiGraphics toolbox

The drawing tools at the top of the Toolbox represent
the tools for drawing and editing images or image ar-
eas and importing text and clip art.  If the Work area is
maximized, the Toolbox displays on top of the Work
area.  

To use a drawing tool, select the appropriate tool in
the Toolbox or select the tool from the Tool menu.

ELIXIGRAPHICS BASICS

ELIXIGRAPHICS USER GUIDE 2-5

Drawing tools

 Tool options

Go button

 Pattern button

Preview panel

Foreground/Background

Message panel

Tools header



The drawing tools are described in the "Displaying and
drawing an image" chapter.  

The Transform tool is used to apply transformations,
such as resizing or half-toning, to whole images or im-
age areas and is described in the "Manipulating im-
ages and image areas" chapter.

You can set the tool options by clicking on icons in the
Toolbox.  Setting options for a drawing tool is de-
scribed in the "Displaying and drawing an image"
chapter.

The Message panel provides a short description of
any selected tool in the Toolbox.

The Preview panel allows you to preview the option
settings for a drawing tool before you perform any
drawing operations.

You can toggle between hiding and showing the Tool-
box by pulling down the Window menu and selecting
[Tools] or by pressing <F10>.  To move the Toolbox,
click on the Tools header and drag the Toolbox to the
desired location.

Go
The [Go] button is used to apply the transformations
described in the "Manipulating images and image
area" chapter.

Pattern button
This button shows the current shading pattern when
drawing in color or black-and-white.  Clicking on this
button allows you to apply the shading patterns de-
scribed in the "Displaying and drawing an image"
chapter.

Highlight color users have the additional option of ap-
plying the shading patterns described in the "Working
with highlight colors" appendix.

FG/BG
The [FG] (foreground) button allows you to select the
color of your drawing tool.

The [BG] (background) button allows you to set a
background color when performing some of the trans-
formation and drawing operations described in the
"Displaying and drawing an image" chapter and the

ELIXIGRAPHICS BASICS
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"Manipulating images and image areas" chapter.  The
[BG] button also allows you to set a background color
when creating a new image.  See the "Creating a new
image" section of this chapter for more information.

If you are a Black and White or highlight color user,
click on the [FG] or [BG] button until the color you
want is displayed.

If you are a full-color user, click on the [FG] or [BG]
button and double-click on a color from the window
that displays.

Toolbar

The following figure displays the Toolbar.

Figure 2-4.  ElixiGraphics Toolbar.

The Toolbar icons provide the following drawing sup-
ports for the drawing tools:  

Digital ruler
This tool allows you to display the position of a draw-
ing such as a line, circle, or box relative to the image
area, or to display the height and width of a drawing
while using certain drawing tools.  This tool is de-
scribed in the "Additional features" chapter.

Magnification/Reduction
This tool allows you to magnify or reduce an image
and is described in the "Displaying and drawing an im-
age" chapter.

Undo/Redo
The Undo/Redo feature allows you to reverse actions
in ElixiGraphics if the [Number of Undo Levels] option
in the Preferences dialog box is set to one or more
levels.  See the "Usage switches" section in this chap-
ter for more information.  

Digital ruler

Magnification/
Reduction

Undo/Redo

Drawing modes

  Grid

ELIXIGRAPHICS BASICS
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To undo an operation, click on the Undo icon in the
Toolbar or pull down the Edit menu and select [Undo].
You can also use the <Ctrl> + <Z> fast keys.

To redo an operation that was undone using the Undo
feature, click on the Redo icon in the Toolbar or pull
down the Edit menu and select [Redo].  You can also
use the <Shift> + <Ctrl> + <Z> fast keys.  

Drawing modes
These icons (from left to right) allow you to access the
opaque, transparent, and reverse drawing modes de-
scribed in the "Displaying and drawing an image"
chapter. 

Grid
This icon allows you to toggle on a grid when display-
ing magnified views of 8x or more.

Message area

The Message area is split into two sections.  The left
section displays the type of image loaded in the Work
area, and operational and error messages.  The right
section provides a description of an icon when you
place your cursor over it.

Using ElixiGraphics

This section provides a brief overview of how to use
ElixiGraphics, including information about configuring
ElixiGraphics when you first start using it.  If you have
never used ElixiGraphics, you may want to read all of
this section.  In it, you will be referred to other chap-
ters in this User Guide which provide more detailed
information.

Configuring the system

ElixiGraphics allows you to configure your system and
then save the configuration.

ELIXIGRAPHICS BASICS

2-8 ELIXIGRAPHICS USER GUIDE



Usage switches

Pull down the System menu and select [Usage
Switches] to display the Preferences dialog box.

Figure 2-5.  Preferences dialog box

Save state on exit
Select this option if you want to save the menu and
option settings when you exit an image.

Show quick help
Select this option to see the quick help messages de-
scribed in the "Introduction" chapter.

Confirm file overwrites
Select this option if you want to be prompted before
overwriting a file.

Confirm leaving unsaved work
Select this option if you want to be prompted to save
your work before exiting ElixiGraphics.

Use Elixir font selector
Select this option if you want to use the Elixir Font Se-
lector when you select fonts for your text.  The Elixir
Font Selector allows you to select non-default font
widths.

ELIXIGRAPHICS BASICS
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Deselect this option if you want to use the Windows
Font Selector when you select fonts for your text.  The
Windows Font Selector allows you to select only Win-
dows default fonts.

See the "Using text and clip art" chapter for more
information.

Keyboard mapping
Select the [Keyboard Mapping] option:

Select [None] to use Windows ANSI map-
ping.  If you select this option you must have
screen fonts mapped to Windows ANSI
mappings. 

Select [ANSI to OEM] to remap ANSI key-
strokes to DOS mappings. 

Select [KMP] to translate keystrokes using
customized tables.  In most cases, if you
chose the appropriate Country Keyboard Map
and Default Code Page during installation,
you can use this option. 

Number of undo levels
Select the number of actions or levels (between 1 and
32) that ElixiGraphics can reverse when you use the
[Undo] option.

Xerox catalog name
This option is for highlight color users only.  Select the
catalog for your printer: [XEROX] or [XEROX1].

Configurable colors

The Configurable Colors dialog box allows you to
change the color of the grid lines and the locator box.
(See the "Displaying and drawing an image" chapter
for a description of the grid lines and locator box.)

To display the Configurable Colors dialog box, pull
down the System menu and select [Colors].  

ELIXIGRAPHICS BASICS
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Figure 2-6.  Configurable Colors dialog box

The current colors for the grid lines and locator box
are displayed.  To change the colors of either the grid
lines or locator box, click on the corresponding [Edit]
button to display the Color RGB Editor dialog box.

Figure 2-7.  Color RGB Editor dialog box

RGB values are Red, Green, and Blue color compo-
nents that combine to create a color.  Use the right
and left arrows next to each color, or click inside the
corresponding box, to specify a component value be-
tween 0 and 255.  The Result window displays the re-
sults of mixing Red, Green, and Blue color
components.

When you accept your changes by clicking on [OK],
your grid lines or locator box displays in the color
shown in the Results box.

ELIXIGRAPHICS BASICS

ELIXIGRAPHICS USER GUIDE 2-11



System information

For information regarding your current Windows
screen driver, memory, and disk space available, pull
down the System menu and select [System Info], or
pressing <Alt> + <F5>.  The System Information dia-
log box displays.

        Figure 2-8.  System Information dialog box

Reset to defaults

If you change the configuration settings while using
ElixiGraphics, you can reset to the default configura-
tion by pulling down the System menu and selecting
[Reset to defaults].

Save configuration

To save current menu and option settings, pull down
the System menu and select [Save Configuration] be-
fore exiting an image.

Loading an existing image

ElixiGraphics allows you to load up to two images at
one time.

With the ElixiGraphics main screen displayed, load an
existing image as follows:

1. Pull down the File menu and select [Load] or
press <F8>.
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The Load Image dialog box displays with an al-
phabetical list of all available images.  If you
elected to install them, the names of demonstra-
tion files are listed.  These are Elixir-format .LP3
files in drive:\ELIXIR\PICS\PRINTER.  To display
.BMP images, select [.BMP] from the window at
the bottom of the dialog box.

           Figure 2-9.  Load Image dialog box.

If there are more files than can be displayed, use
the scroll bar to move through the list. 

2. Select an image file.

The file displays in the Work area and the file
name displays in the Work area menu bar.  The
following figure shows the demonstration file
STARS.LP3 displayed.  
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Figure 2-10.  Loaded file

3. To load another image, pull down the Window
menu and select [Another Image] to re-display
the Load Image dialog box.

4. Select an image.

You now have two images loaded in two separate
windows.

5. Pull down the Window menu and select one of
the following:

[Cascade] displays the images in two sepa-
rate overlapping windows.

[Horiz. tile] displays the images side by side.

[Vert. tile] displays one image above the
other.
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Displaying image attributes

To display the image attributes, pull down the Image
menu and select [Attributes] or press <F2>.  The Im-
age Attributes dialog box displays.

      Figure 2-11.  Image Attributes dialog box

The Image Attributes dialog box displays the following
information: width, height, name, resolution, color sys-
tem, format, image memory size and memory avail-
able.  If the image is a highlight color image, the
highlight color being used also displays. 

You can select a different resolution only when using
the image in other applications, for example when us-
ing Elixir Desktop converters to convert the file to
other formats.  Note that the image resolution of the
converted file must be supported by the target printer.
The resolution also affects the size of the image when
importing it into ElixiForm: the higher the resolution,
the smaller the image on the form.

The [Color System] option allows you to convert a
loaded image to [Black & White], [Highlight Color], or
[Full Color], depending on the image you have loaded
and the color system your printer supports.

The following information applies to HighLight Color
users only:
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When your color system is set to [HighLight
Color], the [HighLight Color] option displays and
allows you to change the current highlight color by
pulling down the list and selecting another color.

If the currently loaded image is a highlight color
image, the [Swap Color Planes] option displays.
Click on this option to switch the highlight color
plane and the black plane. 

For more information about HighLight Color, see the
"Working with highlight colors" appendix. 

Editing and saving an image

ElixiGraphics allows you to edit up to two images at
one time.

To edit a displayed image:

Use the edit/drawing tools in the Toolbox.  The
edit/drawing tools are described in the "Displaying
and drawing an image" chapter.

Use the Transform tool to transform a whole im-
age or image area.  See the "Manipulating im-
ages and image areas" chapter for more
information.

After making changes to an image you can do the
following:

Pull down the File menu and select [Save] (or
press <Ctrl> + <S>) to save your changes to the
current file.  To save your changes to a new file
pull down the File menu and select [Save as] (or
press <F7>).  The Save Image dialog box dis-
plays which allows you to specify a new file name.

Pull down the Edit menu and select [Undo], or
click on the Undo icon in the Toolbar, to undo the
last edit or transform operation.
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Pull down the Edit menu and select [Redo], or
click on the Redo icon in the Toolbar, to re-insert
the changes you made before you selected
[Undo].

Pull down the File menu and select [Reset] to de-
lete any changes made since loading or saving
the file.

Pull down the Edit menu and select [Delete], or
press <Del>, to delete everything in the Work
area. 

Creating a new image

To create a new image:

1. Click on [BG] to select the color of the
background.

2. Click on [FG] to select the color of the
drawing tool.

3. Pull down the File menu and select [New] or
press F9. 

               Figure 2-12.  Image Attributes dialog box options

The Image Attributes box displays the following
options:
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Width
Specify the width of the new image in dots.

Note that ElixiGraphics rounds image widths up to
the nearest multiple of eight dots.  

Height
Specify the height of the new image in dots.

Name
Specify a name for the image.  The default name
is UNTITLED.LP3.

Standard Sizes
Select [Letter] to create an 8.5 x 11 image,
[11x17] to create an 11 x 17 image, [A3] to create
a European legal-size image, or [A4] to create a
European letter-size image.

Resolution
Select [200], [240], [300], [480], [600], [1200], or
[1440] dpi resolution.

Color System
Select the color system for the image you want to
create: [Black & White], [Highlight Color] or [Full
Color].

Format
Select a format for the new image: [.LP3] or
[.BMP].

Highlight Color
This option is for highlight color users only.  When
the [Color System] option is set to [Highlight
Color], specify [RED], [GREEN], or [BLUE].  

When using an ElixiGraphics image in ElixiForm,
the highlight color set in the ElixiForm application
overrides the ElixiGraphics image highlight color.

You can change the ElixiForm highlight color at
the highlight color printer console.

4. Click on [OK] and use the drawing tools to
create a new image.
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Resetting an image

When you reset an image, you clear all edits since the
last save operation.  To reset an image, pull down the
File menu and select [Reset].

Refreshing the screen

If a Windows operation leaves "snow" on the screen,
you can use the [Refresh View] option to redisplay the
image bitmap from memory onto the screen.  Pull
down the Image menu and select [Refresh View].

Proof-printing an image

When you are ready to proof print your image, pull
down the File menu and select [Print] or press <Ctrl>
+ <Shift> + <F10>.  The Print dialog box displays.

Figure 2-13. Print dialog box

The Print dialog box contains the following options:
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Printer
Choose your printer as a PCL 4 or compatible, Xerox
4045 or Xerox 2700/4045 printer.

Elixir software has been tested with HP Windows
printer drivers for proof printing.  Other printer drivers
are not supported and may produce unpredictable re-
sults when used with Elixir software.

PCL 4 considerations
PCL 4 printers print a maximum page size of 8 x
10.33 inches.  If your graphics' boundaries fill an 8.5 x
11 inches page, the outer margins of your image will
not print on a PCL 4 printer.

For accurate positioning, shift the print image on the
page using the [Page Shift] option in the Print dialog
box.

Orientation
Select the orientation for your page, [Landscape] or
[Portrait].

Page shift
Select [Page Shift] to shift your proof printer output
horizontally or vertically by the number of dots
specified.

[Xshift] moves your image horizontally and [Yshift]
moves your image vertically.

Use a negative shift value to shift the printed output to
the left or down, and a positive value to shift the
printed output to the right or up.

For a PCL 4 or compatible printer, the normal or cen-
tered image value is [Xshift] = -60.

Copies
Select the number of copies you want to print.

Use printer resolution
Select this option to print your image using the current
printer resolution.  If you do not select this option, your
image is printed using the image resolution.
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Print to file
When [Print to File] is selected, ElixiGraphics outputs
a print file to the drive:\ELIXIR\PRINTS\HPPRINT\ di-
rectory with a .PRN extension.  

Autogen output name
When you select the [Print to File] option, the [Auto-
gen Output Name] option also displays.  If  you select
this option, ElixiGraphics automatically outputs the
print (.PRN) files with the same stem name as the
Elixir (.ELX) file.  If you do not select this option, the
Print To File dialog box displays after you click on
[OK].  Enter the stem name for the file, up to eight
characters.

Additional features

The preceding sections provide a brief overview of
how to use ElixiGraphics. The following chapters pro-
vide detailed information about ElixiGraphics draw-
ing\editing tools and features.
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3. Displaying and
 drawing an image

This chapter describes how to load and display an im-
age and how to use the drawing tools.

Displaying an image

When you load an image in ElixiGraphics the image
displays in the Work area.

Fig 3-1. Displaying an image in the Work area
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The image is bound by a gray, uneditable region.
However, the image can be enlarged to extend into
the gray area as described in the "Additional features"
chapter.

A message displays in the message area identifying
the color mode of the loaded file: [Black-and-White],
[Highlight Color], or [Full Color].

Note that the square border around the image is not
part of the image.

View settings

This section describes how to display a magnified
view or a reduced view of an image using the Zoom
icon in the Toolbar.  The Magnification window dis-
plays the current magnification level of an image.

Magnifying an image

Click on the up arrow in the Zoom icon (or press the
<+> key on the numeric keypad) to magnify the center
of the image and to display it in a window to the left of
the Work area.  

The magnification factor displays in the Magnification
window.  The default magnification factor is 1x.  Use
the up arrow, or press the [+], to increase the magnifi-
cation factor to 2x, 4x, 8x, 16x, or 32x magnification.
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         Figure 3-2.  Magnified view

The magnified area in the left window is defined by the
Locator Box in the right window.  Click inside the Lo-
cator Box and drag it to magnify a different area of the
image.  To change the color of the Locator Box, see
the "ElixiGraphics basics" chapter.

Alternatively, you can use the arrow keys or the scroll
bars to move around and display different portions of
the image.

Click on the Grid icon in the Toolbar to display the
grid.  The grid displays only at magnifications of 8x or
higher.

All drawing tools described in the following sections
work in magnified view.

Note that displaying an image at a magnification factor
of 16X or more may cause your system to become
unstable.  
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Reducing an image

Before building a reduced view of an image, select a
Stretch mode.  Stretch mode affects the way an im-
age displays when it is reduced.  To select a Stretch
mode, pull down the Image menu and select [Stretch
Mode].  Select one of the following options:

[Color on Color] preserves black, white, and color
pixels when an image is reduced and is probably
the best mode for performing image reductions.

[Black on White] preserves black pixels at the ex-
pense of white pixels when an image is reduced.

[White on Black] preserves white pixels at the ex-
pense of black pixels when an image is reduced.

To display a reduced view of an image, click on the
down arrow in the Zoom icon or press the <-> key on
the numeric keypad.

Initially, the image displays at print size (PRN) which
allows you to preview an image at actual size.

Click on the down arrow again to display the image at
 -2x, -4x, and -8x reduction factors.

This feature is especially useful when you want to fit a
large image into the Work area.

Note that you cannot edit an image in a reduced view.
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Using the drawing tools

The drawing tools display at the top of the Toolbox
and drawing options display in the Toolbar.

To use a drawing tool, select it from the Toolbox or
from the Tool menu.  In the figure on the left, the Line
tool is selected.

You can select options for your drawing tools.  The
drawing tool you select determines the options avail-
able in the Toolbox.  Drawing tool options are de-
scribed in the following sections.

All drawing operations are performed by clicking and
dragging the mouse in the Work area. 

Note that you can use all the tools described in this
section in the magnified view mode described earlier
in this chapter.

FG button

The [FG] button allows you to select the color of a
drawing tool as black, white or color, depending on the
color mode selected for your image.  

If you are creating a black and white or highlight color
image, select a color by clicking on the [FG] button
until it displays the color you want.

If you are a full-color user, the Choose Foreground
Color dialog box displays when you click on the [FG]
button.  Double-click on the color you want to use.

BG button

The [BG] button allows you to set the background
color when creating a new image, entering text, and
performing some of  the transformation operations de-
scribed in the "Manipulating images and image areas"
chapter.  The [BG] button also allows you to set the
color of a fill when drawing filled shapes, as described
in appropriate sections of this chapter.  

FG

BG
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If you are creating a black and white or highlight color
image, click on the [BG] button until it displays the
background color you want.

If you are a full-color user, the Choose Background
Color dialog box displays when you click on the [BG]
button.  Double-click on the color you want to use. 

Pattern button

The currently-loaded pattern displays in the Pattern
button.  Click on the Pattern button to display the Pat-
tern window from which you can load a shading pat-
tern described in the "Drawing patterns" section of this
chapter.    

If you are a highlight color user, you can also choose
one of the highlight color shading patterns described
in the "Working with highlight colors" appendix.  Click
on [High...] to display the highlight color shading
patterns.

If you are a full-color user, you can also choose one of
the colors from the full-color palette.  Click on [Full...]
and select a color from the pattern window.

GO button

Use the [Go] button to apply the transformation opera-
tions described in the "Manipulating images and im-
age areas" chapter.

Border width

The up and down arrows in the Toolbox are used to
set the border width of lines, shapes, brush and pencil
tips, and the eraser.

To set the border width, click on the up arrow to in-
crease the width, or on the down arrow to decrease
the width. The border width displays in the numeric
display box next to the up and down arrows.  

DISPLAYING AND DRAWING AN IMAGE

3-6 ELIXIGRAPHICS USER GUIDE



You can also change the current value by backspac-
ing over it and entering a new value.  Alternatively, you
can click once in the numeric display box and specify
the lowest border width value by <Ctrl> - clicking in the
box, or the highest border width value by <Shift> -
clicking in the box. 

Border style

Select [Solid], [Dashed], or [Dotted] borders when
drawing lines or shapes.

Line

The Line tool allows you to draw single, connected, or
radial lines.  

Figure 3-3.  Line options

Select from the following options in the Toolbox:
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Line direction
Select the line direction: [Horizontal], [Vertical], [Both],
or [Free].

Select [Horizontal] to draw a line in the hori-
zontal direction only.

Select [Vertical] to draw a line in the vertical
direction only.

If you are drawing connected lines and want
to scroll around the image, the line will stay
connected to the last point.  This feature en-
ables you to draw long lines across large im-
ages which do not fit in the Work area.

Select [Both] to draw a line in the horizontal or
vertical directions, depending on mouse
movement.

Select [Free] to draw a line in any direction,
including diagonal.

Line beginning and end style
Select the line beginning (top row) and end style (bot-
tom row).  Select [Square], [Round], or [Mitered] for
each end of your line.  Line beginning and end styles
are most apparent at line widths of 10 or above.

Note that the [Mitered] option is available with diago-
nal lines only.

The following figure illustrates the effects of [Square],
[Round], and [Mitered] ends.
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Figure 3-4.  Line end examples

Line style
Select [Single], [Connected], or [Radial].

Select [Single] to draw a single line between
mouse clicks.

Select [Connected] to connect lines between
successive mouse clicks, until you select an-
other line style or drawing tool.

Select [Radial] to create lines that radiate
from a single point.  This option applies to
[Free] direction lines only.

Note that the [Undo] option is not available for radial
lines.

You can change the line properties while drawing a
line.  You can also use different line widths while
drawing a line as shown in the following figure.
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Figure 3-5.  Connected lines with different widths

Curve

The Curve tool draws sections of circles or ellipses.
Connecting curves together enables you to produce
high quality line art.  

Figure 3-6.  Curve options

Select from the following options in the Toolbox:
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Curve type
Select [Quarter Circle] to use sections of circles to
draw curves or select [Quarter Ellipse] to use sections
of ellipses to draw curves.

Curve direction
Select [Horizontal], [Vertical], or [Any].

Select [Horizontal] to draw the curve
horizontally.

Select [Vertical] to draw the curve vertically.

Select [Any] to draw the curve in any
direction.

Curve style 
Select [Single], [Connected], or [Radial].

Select [Single] to draw curves one at a time.

Select [Connected] to connect curves be-
tween successive mouse clicks until you se-
lect another curve mode or drawing tool.

Select [Radial] to create curves continuously
from one point.

The following figure shows examples of curves in the
three different modes.

Note:  The [Undo] option is not available for radial
curves.
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Figure 3-7.  Curve examples

Box

The Box tool allows you to draw hollow or filled
squares or rectangles with squared or rounded cor-
ners.  The width of the box border is determined by
the [Border Width] option.  

Figure 3-8.  Box options
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Select from the following options in the Toolbox:

Box shape
Select to draw a [Square] or [Rectangle].

Box corners
Select [Square] or [Rounded] corners.

Box type
Select [Hollow] or [Filled].  If you select [Filled], the
box fills with the fill pattern or color displayed in the
Pattern window.

Corner radius
Select [Custom] or [Maximum].

Select [Custom] to set the width and height
dimensions of rounded corners using the up
and down arrows next to the Width and
Height boxes.

Select [Maximum] to draw a square or rectan-
gle with rounded corners of equal height and
width dimensions. 

The following figure shows examples of boxes.

Figure 3-9.  Box examples

Note that square boxes appear distorted on the
screen when the screen aspect ratio is not 1:1.  How-
ever, these boxes print correctly.
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Ellipse/Circle

The hollow or filled Ellipse/Circle tool allows you to
draw hollow or filled circles and ellipses.  The width of
the circle or ellipse border is determined by the [Bor-
der Width] option.

Figure 3-10.  Ellipse/Circle options

Select from the following options in the Toolbox:

Circle/Ellipse shape
Select to draw a [Circle] or [Ellipse].

Ellipse/Circle origin
Select [Center] or [Upper Left Quadrant].

Select [Center] to draw a circle from the cen-
ter outward, where the anchor point is the
circle/ellipse center.

Select [Upper Left Quadrant] to draw an el-
lipse or circle that expands outward with one
quadrant of the circle or ellipse remaining an-
chored in the starting position.  This method
allows you to place the shape more precisely
in relation to another object.
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Ellipse/Circle segment
Select one or more of the four segments to display
that segment of a circle or ellipse. 

 
Ellipse/Circle type
Select [Hollow] or [Filled].  Selecting [Filled] draws cir-
cles and ellipses with the fill pattern displayed in the
Pattern window.

Figure 3-11.  Circle and ellipse examples
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Polyline/Polygon

The Polyline tool draws polylines or filled and unfilled
polygons.

To draw a polyline or polygon, move the screen
pointer into the Work area, click in the image to start
drawing, and keep moving and clicking to draw the
line segments of the polyline or polygon.  To end a
polyline or polygon, double-click the left mouse button.

Figure 3-12.  Polyline/Polygon options

Select from the following options in the Toolbox:

Polyline/Polygon 
Select [Open] or [Closed].

Select [Open] to draw a polyline.

Select [Closed] to draw a polygon.

Polyline/Polygon direction
Select [Horizontal & Vertical] or [Free] line segments.

Select [Horizontal & Vertical] to draw lines
that snap to horizontal or vertical lines.
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Select [Free] to draw lines in any direction.

Polygon fill mode
Select [All] or [Alternate] fill mode.

Select [All] to fill the entire polygon with the
pattern or color displayed in the Pattern
window.

Select [Alternate] to only fill areas that are ac-
cessible from the outside of the polygon by
crossing an odd number of lines.

Figure 3-13.  Alternate polyline

Polyline/Polygon type
Select to draw a [Hollow] or [Filled] polygon.  

Selecting [Filled] draws polygons with the fill pattern or
color displayed in the Pattern window.

Note that the border of the polygon is black only if you
select black using the [FG] button.

Figure 3-14.  Polygon examples
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Pencil 

The Pencil tool draws a continuous line in black or
white.  Highlight color and full-color users have the ad-
ditional option of drawing in color.

Figure 3-15.  Pencil options

Select from the following options in the Toolbox:

Pencil tip
Select [Square] or [Rounded].

Select [Square] to draw individual dots or a
continuous line with squared ends.

Select [Rounded] to draw individual dots or a
continuous line with rounded ends.

For high-precision work in magnified view, you should
use the Pencil tool with a drawing width of [1].

Note that to see the difference between a [Square]
and [Rounded] pencil tip, select a border width of five
dots or more.
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Brush

The Brush tool paints continuous square or circular
dots, or in a series of horizontal, vertical, or diagonal
lines, depending on the drawing mode you select.
Click and drag the brush tip to generate a shape.

The Brush tool paints in black, white, or the currently-
selected fill pattern.

Highlight-color and full-color users have the additional
option of drawing in color.

Figure 3-16.  Brush options

Select from the following options in the Toolbox:

Basic brush tips
Select a [Square] or [Rounded] brush tip.

Select [Square] to paint continuous square
dots.

Select [Rounded] to paint continuous circular
dots.

Special brush tips
Select [Horizontal], [Vertical], [Diagonal Right], or 
[Diagonal Left].
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Select [Horizontal] to paint a series of con-
tinuous horizontal lines.

Select [Vertical] to paint a series of continu-
ous vertical lines.

Select [Diagonal Right] to paint a series of
continuous diagonal lines that slant to the
right.

Select [Diagonal Left] to paint a series of con-
tinuous diagonal lines that slant to the left.

The following figure is an example of the effect of the
[Horizontal], [Vertical], [Diagonal Right], and [Diagonal
Left] brush tips.

To achieve a continuous painting action, draw slowly
so that brush tips overlap.

Figure 3-17.  Samples of brush drawing

Brush type
Select [Dots] or [Pattern].

Select [Dots] to paint in black, white or color.  

Select [Pattern] to paint with the pattern or
color displayed in the Pattern window.
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Airbrush 

The Airbrush tool simulates the effect of an airbrush
by "spraying" dots or patterns on the image.

To "spray", press and hold the mouse button.

Figure 3-18.  Airbrush options

Select from the following options in the Toolbox:

Spray type
Select [Dots] or [Pattern].

Select [Dots] to spray black, white or color
dots.

Select [Pattern] to spray with the pattern or
color displayed in the Pattern window.  

Area Width/Height
The [Area Height] and [Area Width] options set the di-
mensions of the spray area (the area in which dots
are randomly sprayed).  You may want to experiment
with thin spray areas (for example, width: 6, height: 15
to 99) first.
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Use the up and down arrows in the [Area Height] and
[Area Width] options to set the size of the spray in
dots.  Alternatively, click in the box and enter a value.

Spot characteristics
Use the up and down arrows in the [Spot Size] and
[Spot Border] options to set values in dots.  Alterna-
tively, click in any of the boxes and enter a value.

The [Spot Size] option determines the size of
the spots the Airbrush sprays.  As some
Xerox printers cannot print single dots, you
should select a spot size of 2 or larger for cor-
rect printing.  

The [Spot Border] option determines the bor-
der width of the spots.  You can use this fea-
ture to create special effects.  For example,
try a spot size of [9] with a border of [1], and
paint using a gray tone pattern.

Figure 3-19.  Airbrushing examples

Floodfill

The Floodfill tool allows you to fill an area bound by
the current foreground color, or fill an area already
having the current foreground color.  You can use the
current background color or pattern as floodfill.
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Note that this function may not work correctly if Elixi-
Graphics is running under the Windows 95 operating
system, or if the image is 64 KB or larger. 

Figure 3-20.  Floodfill options

Select from the following options in the Toolbox:

Floodfill mode
Select [Interior] or [Solid].

Select [Interior] to fill an area bound by the
current foreground color with the current pat-
tern or the background color, depending on
your [Floodfill Type] selection.

Select [Solid] to fill areas having the current
foreground color with the current pattern or
the background color, depending on your
[Floodfill Type] selection.

Floodfill type
Select [Color] or [Pattern].

Select [Color] to fill an area with the current
background color displayed in the [BG]
button.
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Select [Pattern] to fill an area with the current
pattern.

The following figure shows the beach flood-filled with
a brick pattern.

    Fig 3-21.  Floodfill example

Note that if an area is already filled, you can replace
that area with another pattern or color only if the area
is defined by a border color that is different from the fill
color or pattern.  

For example, if you have a shape with a highlight color
border, and a black and white pattern fill, you can re-
place the black and white pattern with another black
and white pattern, solid black or solid white.  However,
if the shape border is black or white, you can not re-
place the black and white pattern because the border
color is the same as the pattern color.

DISPLAYING AND DRAWING AN IMAGE

3-24 ELIXIGRAPHICS USER GUIDE



Eraser/Replacer

Use the Eraser/Replacer tool to clear portions of an
image to white, black, color, or the current pattern. 

Figure 3-22.  Eraser options

Select from the following options in the Toolbox:

Eraser mode
Select [Stretchy Box] or [Moving Box].  

Select [Stretchy Box] to erase using a rectan-
gular box in the image area.  Press and hold
the mouse button to start drawing the box
then, as you move the mouse, the box
stretches and erases the area contained in
the box.

Select [Moving Box] to display a square with
the dimensions set in the [Border Width] op-
tion.  While holding down the mouse button,
drag the pointer.  The area covered by the
square is erased.

Eraser direction
If [Moving Box] is selected, select [Horizontal], [Verti-
cal], [Both], or [Free].
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Select [Horizontal] to erase in a horizontal di-
rection only.

Select [Vertical] to erase in a vertical direction
only.

Select [Both] to erase in a horizontal and ver-
tical direction only.

Select [Free] to erase in any direction.

Pixel replacement
Select [All] or [Color replace].

Select [All] to clear the whole area with the
current background color, or pattern if the
[Eraser/Replacer Type] option is set to
[Pattern].

Select [Color Replace] to replace sections
having the current foreground color with the
current background color, or pattern if the
[Eraser/Replacer Type] option is set to
[Pattern].

Eraser/Replacer type
Select to [Erase with BG Color] or [Erase with
Pattern].

Select [Erase with BG Color] to erase/replace
with the current background color.

Select [Erase with Pattern] to erase/replace
with the current pattern or color.

Text tool

The Text tool allows you to import clip art images and
to insert text in your images.  Using the Text tool is
described in the "Using text and clip art" chapter.
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Transform tool

The Transform tool is used for copying, moving, creat-
ing clip art, and for transforming an image or a
marked image area.  Using the Transform tool is de-
scribed in the "Manipulating images and image areas"
and "Using text and clip art" chapters.

Drawing modes

You can select the drawing mode option from the
Toolbar.  These options affect all drawing tools.

The three options are (from left to right) [Replace]
(opaque), [Transparent] and [Reverse].  The following
figure shows the effect of superimposing a filled rec-
tangle using (from top to bottom) the [Replace],
[Transparent], and [Reverse] options.

The drawing modes work for copy operations and all
the drawing tools except the Eraser. 

Figure 3-23. Drawing modes

In replace (opaque) mode, drawing over another
shape replaces the shape underneath. 
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In transparent mode, drawing does not erase any
shapes underneath. 

In reverse mode, drawing reverses the color of
the shapes underneath.

Drawing patterns

Click on the Pattern button to display the Pattern win-
dow.  The window displays a number of pre-defined
black and white shading patterns.

To select from the full-color window, click on
[Full].

To select highlight color shading patterns,
click on [High].  See the "Working with high-
light colors" appendix for more information.

Select a pattern from the Pattern window by clicking
on it.  The pattern displays in the Pattern window and
is available for use with the appropriate drawing tools
described earlier in this chapter.

Placing the cursor over a pattern displays the name in
the Pattern name box.

To close the Pattern window, double-click on the
Close button. 

To move the Pattern window, click on the Pattern
header and drag the menu to the desired location.
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Figure 3-24.  Black-and-White Pattern window

Editing patterns

To edit the currently selected shading pattern, click on
the Pattern button using the right mouse button.  The
Shading Pattern window displays from which you can
edit the current pattern.

If you want to edit a highlight color shading pattern,
see the "Working with highlight colors" appendix.
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Figure 3-25.  Shading Pattern window

The right side of the window shows the pattern at nor-
mal magnification.  The left side of the window dis-
plays a magnified image of the pattern bitmap.

The edit area is within an 8 x 8 dot grid at the center
of the magnified bitmap area.

When you edit a black-and-white shading pattern and
save your changes, the changes are saved to memory
only, they are not saved to your hard disk.  To store
the edited bitmap with other program settings, you can
save the current configuration by pulling down the
System menu and selecting [Save Configuration]. 

Although you can use all the drawing tools to edit the
pattern bitmap, it is easiest to use the Pencil tool with
a width of one for precision editing.
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You can also apply the transformation operations de-
scribed in the "Manipulating images and image areas"
chapter to a pattern bitmap.

You can edit a pattern bitmap in black or white by se-
lecting black or white with the [FG] button.
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4.  Manipulating images
and image areas

ElixiGraphics includes features that allow you to ma-
nipulate (transform) a loaded image or a marked rec-
tangular area within a loaded image.

You can perform the following transformation opera-
tions on the whole image: move, resize, rotate, mirror,
distort, clear, reverse, shift, halftone, outline, darken,
lighten, filter, or copy to and from the Windows
Clipboard.

You can perform the following transformation opera-
tions on an area in an image: all the above operations
plus moving, copying, and saving marked areas in the
image.

The import and export functions allow you to create or
use clip art images.  These functions are described in
the "Using text and clip art" chapter.

All the transformation operations described above are
performed using options in the Transform menu or
the Transform toolbox, except copying to and from the
Clipboard which is performed using options in the Edit
menu.  
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Figure 4-1.  Select a transformation

Procedures

To move, copy, transform, cut, paste or save an im-
age area, you must first mark the area.  To do this,
select the Transform tool, and then drag the mouse in
the image area.  A dashed box displays around the
marked area.  The marked area can then be moved,
copied, transformed, cut, paste or saved using the
procedures described in the following sections of this
chapter.  
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Figure 4-2.  Marking an area

You do not have to mark an area if you are copying,
moving, transforming, cutting, pasting or saving a
whole image.

Moving

The move operation allows you to move a marked
area to another area, leaving a blank space in place of
the marked area. 

To move an area, click in the marked area (the screen
pointer changes to a hand) and drag the mouse.  The
area attaches to the screen pointer.  Release the
mouse button to place the area in a new location.  A
blank space is left in place of the marked area.
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Copying

The copy operation allows you to make single or multi-
ple copies, leaving the original image or marked area
in place.  

To make a single copy, <Ctrl>-click in the marked
area (the screen pointer changes to a hand) and drag
the mouse.  Release the mouse button to place the
area.

To create multiple copies, repeat the procedure.

Saving

To save a marked area as an Elixir (.LP3) or Bitmap
(.BMP) image, pull down the File menu and select
[Save Area].  The Save Area into Image dialog box
displays allowing you to specify a file name for the
marked area.

The new image file is written to the  
drive:\ELIXIR\PICS\PRINTER directory.

Transforming images and image areas

To transform an image area, select one of the Trans-
form operations described in the following sections.
Click on the [Go] button after marking an area and se-
lecting the desired transformation options.

If you are transforming an entire image, simply click
on the [Go] button without marking an area.  Alterna-
tively, pull down the Edit menu and choose [Select All]
to outline the entire image and then click on the [Go]
button to apply the transformation.  To deselect the
image, pull down the Edit menu and choose [Unse-
lect] (or press <Ctrl> + <A> to toggle between select-
ing and unselecting an image).

Successively click on the [Go] button to reapply
transformations.
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You can also transform an image area "on the fly"
while moving or copying the area by using the appro-
priate <Ctrl>-fast key combination.  All transformations
except the Resize, Clear, and Shift transformations
can operate in this manner.

Note that the current Toolbox option settings for a
transformation are applied when using this method.

See the "Keyboard shortcuts" appendix for a list of the
transformation fast keys you can use "on the fly."

Resize 

This operation allows you to resize an image or image
area up or down in independent horizontal and vertical
percentages which you specify by clicking on the up or
down arrows in the [% In Horizontal] or [% In Vertical]
options.  Alternatively, click in the box next to the up
and down arrows and enter a different percentage.

Figure 4-3.  Resize options
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If you are upsizing image areas, make sure you have
enough space on the right and below the image area
to place the resized area.

Figure 4-4.  Resizing examples

Better results (less distortion) are obtained by resizing
in one step rather than repeatedly resizing.

The maximum horizontal and vertical resize value is
1000%, and the minimum horizontal and vertical
resize value is 10%.

Rotate 

This operation allows you to rotate an image or image
area clockwise or counter-clockwise in 90 degree in-
crements, or 180 degrees.

Select [Clockwise], [Counterclockwise], or [180 de-
grees] as the rotation direction.
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Figure 4-5.  Rotating options

If you are rotating image areas, make sure you have
enough space on the right and below the image area,
as the image is rotated into this area.

The following figure shows the effect of rotating in the
[180 degrees] direction. 

   

 Figure 4-6.  Rotating example
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Mirror

This operation allows you to flip an image or image
area in horizontal or vertical directions.

Select the [Horizontal] or [Vertical] option to specify
the direction in which you want the image flipped.

Figure 4-7.  Mirroring options

The following figure shows horizontal mirroring.

Figure 4-8.  Mirroring examples
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Distort

This operation allows you to distort an image or image
area in any direction.

Distortion is specified by direction and number of pix-
els.  If you slant the area 28 pixels to the right, the top
row of the area will be distorted to the right by 28 pix-
els.  Each successive row will be distorted less until
the last row is not distorted at all.

A benefit to this operation is that through combina-
tions of distortions to the right and upward or to the
left and downward, you can perform arbitrary bitmap
rotations.

 Figure 4-9.   Distorting options

The following figure shows an example of distortion.
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Figure 4-10.  Distort example

Clear

This operation allows you to mark an area in the im-
age and then clear that area or the area outside the
marked area to the current background color.

Select [Inside Area] to clear the marked area, or se-
lect [Outside Area] to clear the image outside the
marked area.

Figure 4-11.  Clearing options
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If a large image is loaded, only the part of the image
that displays in the current window will be cleared.

The following figure shows the effect of clearing out-
side an image area.

Figure 4-12.  Clearing outside an area

Reverse

This operation changes all black dots in an image or
marked area to white, and all white dots in the area to
black.

This operation does not require you to set options in
the Toolbox.  Simply click on the [Go] button to per-
form the operation.

Figure 4-13.  Reversing example
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Shift

This operation allows you to precisely move an image
area or the whole image with respect to its borders.

Select a direction to shift using the up, down, left, or
right arrow, and set the number of pixels you want the
image to shift.

Specify whether you want a [Normal] or [Circular] shift.
[Normal] replaces the area that was moved with the
current background color.  [Circular] begins replacing
the area that was moved with a new version of the im-
age with each click of the [Go] button.

       Figure 4-26.  Shift options

The following figure shows an example of a circular
shift with the bigcat logo.
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Figure 4-14.  Circular shift example

Halftone

This operation allows you to apply line or shading pat-
terns to whole images or image areas.

You can apply halftoning as horizontal, vertical, and
slanted (45° and 135°) lines, or as a shading pattern.

Select [Lines] when applying lines for halftoning.  The
[Width] and [Separation] options control the width and
frequency of lines on the screen, thus varying the lines
per inch of the halftone. 

The color of the halftoning lines is the current fore-
ground color which you can set by clicking on the [FG]
button.

If using a shading pattern to halftone, select [Pattern]
and load the desired shading pattern as described in
the "Displaying and drawing an image" chapter.   

MANIPULATING IMAGES AND IMAGE AREAS

ELIXIGRAPHICS USER GUIDE 4-13



Figure 4-15.  Halftone options

The following figure shows the effect of applying half-
toning to the individual characters of the Xerox logo.

Figure 4-16.  Halftone examples

You can apply different halftone screens to the same
area repeatedly to achieve different effects.

Outline

This operation enables you to produce an outlined
(hollow) version of an image or image area.

Select the width of the outline from the Toolbox.
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Figure 4-17.  Outline options

Note that some Xerox printers cannot print lines with a
width of one dot. If printing on Xerox printers, you
should use 2-dot outlining.

Figure 4-18.  Outline example

Darken

This operation allows you to darken an image or im-
age area by adding one or more pixels next to existing
pixels in the image.

Specify the number of pixels and the direction in which
you want pixels added.  
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Figure 4-19.  Darken options

Figure 4-20.  Darkening example

Lighten

This operation allows you to lighten an image or im-
age area.  Each black area in the image or image
area is contracted by the number of pixels and the di-
rection specified in the Toolbox.  

Note that you cannot reverse a lighten operation using
the [Darken] option, however, you can use the [Undo]
option to restore the pre-lightened image. 
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Figure 4-21.  Lightening options

Figure 4-22.  Lightening example
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Filter

This operation allows you to apply up to six filtering al-
gorithms to an image or image area.

Figure 4-23.  Filter options

The following figure shows the features you can filter:
sharp corners, hanging or "ragged" dots, and single
bits.  Filtering a sharp corner removes the corner dot.

Figure 4-24.  Filtering
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To clean up rough edges on black and white signa-
tures and logos, apply all six filtering algorithms by se-
lecting each one in the Toolbox.  

The following figure shows the effect of applying all fil-
ters to a halftone image area.  The effect is to apply
more contrast to the image.

Figure 4-25.  Filtering example

Import and Export

The Import and Export transform operations are de-
scribed in the "Using text and clip art" chapter.

Copying to and from the Clipboard

You can copy an image or marked area to and from
the Windows Clipboard using the Edit menu.

Copying to the Clipboard

When copying to the Windows Clipboard, pull down
the Edit menu and select either [Cut] or [Copy] (or
press <Ctrl> + <X> for [Cut], or <Ctrl> + <C> for
[Copy]).  

Selecting [Cut] leaves a blank space in the
marked area.
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Selecting [Copy] places the image in the Clip-
board without changing the original image.

You can also copy an area to the Windows Clipboard
using the [Copy Screen Area] option.  To use this op-
tion you must have the screen area you want to copy
visible.  Use the [Copy Screen Area] option as follows:

1. Pull down the Edit menu and select [Copy
Screen Area].

The cursor changes to a hand pointer.

2. Place the finger tip of the hand pointer at the
top left corner of the area you want to copy,
and drag the mouse to the bottom right corner
of the area.  

A temporary box is drawn around the area.  

3. Release the mouse button to copy the area to
the Windows Clipboard.

The message "Block copied to Clipboard" dis-
plays in the Message area.

Pasting from the Clipboard

If you want to paste an image to a specific area, you
must first select the Transform tool and mark the area
where you want the image pasted.  

You must also pull down the Edit menu and select a
paste mode from the Set Paste Mode sub-menu:

Select [Not Clipped] to paste the image in the
marked area at the actual size.  If the image
is larger than the marked area, the image ex-
tends beyond the marked area.

Select [Clipped to Area] to paste the image in
the marked area.  If the image is larger than
the marked area, only part of the image dis-
plays in the marked area.

Select [Fit to Area] to paste the image in a
marked area.  If the image is larger than the
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marked area, the image is reduced so that it
fits in the marked area.

To paste an image from the Clipboard to a marked
area, pull down the Edit menu and select [Paste] (or
press <Ctrl> + <V>).

If you do not mark an area, the image is pasted in the
top left corner of the Work area.

Note for highlight color users:  Color images in the
Windows Clipboard are stored as full color images.
When pasting a full color image onto a highlight color
image, the highlight color image may become polluted
with full color characteristics which may cause unpre-
dictable results when printing.

To prevent this from occurring, pull down the Image
menu and select [Filter Colors] after pasting a color
image from the Windows Clipboard on a highlight
color image.  This step ensures that your image re-
mains a highlight color image and prints correctly on
your proof-printer.
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5.  Using text and clip art

This chapter describes the following:

How to enter text into an image.

Using and creating clip art.

How to tile an image into a font.

How to cut and convert an image area to a char-
acter in a font.

Entering text

ElixiGraphics allows you to enter text into an image
area using Windows alpha-numeric TrueType fonts,
ATM fonts, or Elixir-format fonts.  Note that as Elixi-
Graphics is a bit-mapped image editor, the text can
only be edited while placing it in the image.  Once it is
placed, it can only be edited as a bitmap using the
drawing tools described in the "Displaying and draw-
ing an image" chapter.

If you plan to use Elixir-format fonts, make sure they
are installed in the \ELIXIR\FONTS\ELIXIR directory.
Some fonts are installed in this directory during
installation. 

If you are using the Elixir Desktop, you can also gen-
erate Elixir fonts from outline fonts by using the Elixir
Font Factory supplied with the desktop.  See the Elixi-
Font User Guide for more information about Elixir
fonts and the ElixiSys Desktop User Guide for infor-
mation about generating fonts with the EFont Factory.

You can also use the Elixir Desktop to convert Xerox-
format fonts to Elixir-format fonts for use in
ElixiGraphics.
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You insert text into an image by entering text from the
keyboard and selecting text properties from the Text
toolbox.

To display the Text toolbox, select the Text tool in the
Toolbox or select [Text] from the Tool menu.  The
Text toolbox displays.

 Figure 5-1.  Text toolbox

The Text toolbox allows you to select text properties
and displays the current Windows or Elixir-format font
in the Font window.

To enter text, click in the Work area.  The Enter New
Text dialog box displays.

          Figure 5-2.  Enter New Text dialog box
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Enter characters from the keyboard using the <Back-
space> key or <Delete> key to edit text, and using
<Ctrl> + <Enter> to insert a carriage return (CR).
Click on [OK] to display the text in the Work area with
a box around it if you selected [Box Text], or a cross-
hair pointer if you selected [Free Text].  See the
"Specifying text properties" section of this chapter for
a description of the [Box Text] and [Free Text]
options.

When the text displays with a box around it or a cross-
hair pointer next to it, the text is in blend text mode.
Blend text mode allows you to edit the text, and posi-
tion it anywhere in the Work area.

You can also enter characters from the Soft Keyboard
while in blend text mode.  Select the Soft Keyboard to
open it, then click on the desired characters.  The
characters display at the end of the text you entered
with the standard keyboard.  Ensure that the box
around your text is large enough to view these addi-
tional characters.

Figure 5-3.  Box and Crosshair pointer

To position the text when in blend text mode, move
the cursor inside the box or crosshair pointer until the
cursor changes to a hand, then click and drag the
mouse to move the text to the desired location.  Re-
lease the mouse button to position the text.

Figure 5-4.  Cursor changes to a hand
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To edit the text when in blend text mode, move the
cursor inside the box or crosshair pointer until the cur-
sor changes to a hand, then click on the right mouse
button to display the Change Text dialog box.  Edit the
text and click on [OK] to accept your changes.

Once you are sure of where you want your text posi-
tioned, place the text by clicking outside the text block
and selecting [Cancel] from the Enter New Text dialog
box, or by selecting another drawing tool.  Once text is
placed, you can only edit it as a bitmap using the
drawing tools described in the "Displaying and draw-
ing an image" chapter.

Specifying text properties

Specify text properties by clicking on the options in the
Text toolbox.

Font type
This option allows you to select [Windows] to use
Windows fonts (including symbolic fonts such as
WingDings), or [Elixir] to use Elixir fonts.  Note that
you can only load an Elixir-format font into ElixiGraph-
ics if you have a screen version of the font. See your
ElixiSys Desktop User Guide for information about
generating a screen version of a font.

To use Windows fonts:

1. Select the [Windows] option.

2. Click on the [Font Selection] button. 

The dialog box that displays depends on the [Use
Elixir Font Selector] option in the Preferences dia-
log box.  (See the "ElixiGraphics basics" chapter
for more information about the Preferences dialog
box.) 

If the [Use Elixir Font Selector] option is not
selected, the Font dialog box displays allow-
ing you to select a font name, style, size and
script type from the fonts you have available
within Windows.
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       Figure 5-5.  Font dialog box

If the [Use Elixir Font Selector] option is se-
lected, the Choose Font dialog box displays
allowing you to select the font name, style,
height and width. 

            Figure 5-6.  Choose Font dialog box

3. Select the font you want to use and click on
[OK].

To use Elixir fonts:

1. Select the [Elixir] option.

The Load Font dialog box displays the Elixir-
format fonts currently available in the
drive:\ELIXIR\FONTS\ELIXIR directory.  
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Note that if an Elixir-format font is already loaded,
click on the [Font Selection] button to display the
Load Font dialog box.  

The Load Font dialog box also displays Elixi-
Graphics clip art fonts (described later in this
chapter).  To avoid confusion, ElixiGraphics clip
art fonts are prefixed with a caret (^).

2. Select an Elixir-format font and click on [OK]
to load the font.  

The currently loaded font displays in the Font
window.

You can view an Elixir-format font before entering it in
the Work area by selecting the [Soft Keyboard] option.
 See the "Specifying text properties" section for more
information.

Note that you cannot enter grayed out or "null" charac-
ters in a font.

To close the window, click on the [Soft Keyboard] but-
ton again.

Text boundaries
Select to enter [Box Text] or [Free Text].

Box text is bound by columns.  If you select the [Box
Text] option, you must also select the [Wrap Text] op-
tion (described later in this section) and define the
column.  

To define a column:

1. Select the [Box Text] and [Wrap text] option.

2. Click and drag the mouse in the Work area.

A column displays in the Work area.

3. Release the mouse button when the column is
the correct size.

The Enter Text dialog box displays.
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4. Type the text in the Enter Text window and
click on [OK].

The text displays inside the column.  

5. To resize the column, click and drag any of
the handles. 

Free text is not bound by columns; only by the width of
the image.  

To use the [Free Text] option:

1. Click in the Work area.

The Enter Text dialog box displays.  

2. Enter text and click on [OK].

The text displays as a continuous text string in the
image area .

Note that you can switch between [Box Text] and
[Free Text] until the text has been placed.  However, if
the [Wrap Text] option is deselected when entering
free text and you toggle to [Box Text], the [Wrap Text
option is not automatically activated.  To activate
[Wrap Text] in this situation, select the [Wrap Text]
option and click inside the column.

Text Baseline Rotation
Select the text rotation: [Left to Right], [Bottom to
Top], [Upside Down], or [Top to Bottom].

Note that due to Windows limitations, not all fonts can
be rotated.  If a font does not rotate, select a different
font and try the rotate operation again.

Text Justification
You can justify text when the [Wrap Text] and [Box
Text] options are selected.  Specify the justification for
each text block: [Left Justified], [Center Justified],
[Right Justified], or [Full Justified].

Text Positioning
When the [Wrap Text] and [Box Text] options are se-
lected, specify the vertical positioning of the boxed
text: [Top], [Center], or [Bottom].
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You can use this option with [Text Justification] and
[Box Text] to place the text in twelve positions within
the box.

Note that this option is not available if you have the
[Box Text] option selected for a Windows font type.

FG and BG buttons
Click on the [FG] button to toggle between entering
black, white or color text.  

Click on the [BG] button to toggle between entering
text on a black, white or color background.

Font Selection
Select this option to bring up the Windows or Elixir
font selection dialog box to select a font to load. 

Soft Keyboard 
Select this option when an Elixir font is loaded, to dis-
play the Elixir font in a window below the Work area.
at the correct size in proportion to the image. 
 

Figure 5-7.  Displaying an Elixir font

FG

BG
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Use the scroll bar or <PgUp> and <PgDn> keys to
scroll through the font.

If you are in blend text mode, you can enter text from
the soft keyboard by clicking on individual characters. 

Wrap Text 
Selecting this option toggles between setting [Wrap
Text] on or off.  When you select [Wrap Text], any text
you enter is bound in the box you define in the [Box
Text] option.

Intercharacter Spacing (for Windows fonts only)
Intercharacter spacing allows you to justify text by
adding or deleting spaces between characters.

Enter a value in the [Intercharacter Spacing] option by
using the up and down arrows next to the box, or
clicking in the box and entering a new value.

As you increase the value, the spacing between char-
acters increases.  As you decrease the value, the
spacing between characters decreases.

Drawing Mode
You can enter text using [Replace], [Transparent] or
[Reverse] mode by selecting the appropriate icon in
the Toolbar.  The following figure shows examples of
entering text in the three drawing modes.
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Figure 5-8.  Entering text in an image

Clip art

ElixiGraphics clip art is a collection of images stored
as characters in Elixir-format fonts.  You can think of
each font as a "library" of related clip art.  Because the
clip art is an Elixir-format font, you can convert it to
Xerox printer format and print the clip art as charac-
ters on the Xerox printer.

You can import clip art into your image from an exist-
ing clip art library, or you can create your own clip art
library.  See the following sections for more
information.  

To avoid confusion with normal fonts, ElixiGraphics
clip art file names are prefixed with a caret (^).  During
installation, some clip art fonts are written to the
\ELIXIR\FONTS\ELIXIR directory. 

USING TEXT AND CLIP ART
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Importing clip art

This section describes how to import clips from an ex-
isting clip art (font) library and place them in an image.

Refer to the following figure when importing a clip art
item into a displayed image.

Figure 5-9.  Importing clip art options

To import a clip art item into a displayed image:

1. Pull down the Transform menu and select
[Import] or select the Import tool in the
Transform toolbox.

2. Click on the [Clip Art Library] button.

3. Click on the [Load] button to display the Load
Clipart Library dialog box with all the
currently-available clip art libraries (fonts) in
the drive:\ELIXIR\FONTS\ELIXIR directory.

4. Select a library to display the first "page" of
clips in the library and click on [OK].  

5. Position the cursor over a clip art item until
the clip art cell is highlighted then press the
mouse button.

USING TEXT AND CLIP ART

ELIXIGRAPHICS USER GUIDE 5-11

Clip art library button

Load button



The screen pointer changes to a hand.

6. Drag the image to the Work area and release
the mouse button to position the item.  

Just as with text, you can continue to move the
clip art item until it is placed.

7. Click the mouse outside the clip art item to
place it.

8. Select and position another clip art item or
select another tool.

Figure 5-10.  Placing clip art in an image

The above figure shows how you can create diagrams
using clip art images.

You cannot place a clip art item outside the image. Ar-
eas falling below or to the right of the viewable image
area are discarded.

If you want to cancel the current clip you are dragging,
release the mouse button before the image reaches
the Work area.
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Just as with text, clip art can be added in any of the
three drawing modes.  Select an icon to add clip art in
[Replace], [Transparent] or [Reverse] mode. 

You cannot place grayed out or "null" areas in a clip
art library.

Converting an image to a font

ElixiGraphics allows you to convert all or part of an im-
age into an Elixir-format font.  Using converters in the
ElixiSys Desktop, you can convert the Elixir-format
font to Xerox format and print the font on any Xerox
printer.

You can convert an image into a font by creating a clip
art library, tiling an image into a font, or creating a font
from image portions.  If you are converting an image
area, you must mark the area first, as described in the
"Manipulating images and image areas" chapter.

To perform any of these operations, click on the
Transform tool to display the transformation options in
the Toolbox.  The following sections explain the above
procedures in detail.
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Creating clip art

Refer to the following figure when creating a clip art
item from an area in existing image.

Figure 5-11.  Clip art and Load buttons

You can create a clip art item from an area in an exist-
ing image and save it as a new font or add it to an ex-
isting font.  

To create a clip art item and save it as a new font:

1. Load the image, pull down the Transform
menu and select [Export], or select the Export
tool in the Transform toolbox.

2. Click on the [Clip Art Library] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.
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Figure 5-12.  Choose Target Font File 
dialog box

4. Select [Create New Font].

The Create Clipart Library dialog box displays.

5. Enter a file name following the caret (^) and
click on [OK].  

A font window with a blank character set displays
at the bottom of the screen.

6. Mark an area in the image.

7. With the cursor in the marked area, hold down
the <Ctrl> key and press the mouse button
and drag the image to a blank character cell. 

8. When the cell is highlighted, release the
mouse button to drop the image into the cell. 

9. Click on the [Save] button to save your
changes.

10. Repeat the procedure until your clip art library
is complete.
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Figure 5-13.  Creating a clip art library

To create a clip art item and add it to an existing font:

1. Load the image, pull down the Transform
menu and select [Export], or select the Export
tool in the Transform toolbox.

2. Click on the [Clip Art Library] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.

Figure 5-14.  Choose Target Font File dialog box

4. Select [Load Existing Font].

The Load Clip Art Library dialog box displays 
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5. Select a file to display its contents in a
window at the bottom of the screen.

6. With the cursor in the marked area, hold down
the <Ctrl> key, press the mouse button, and
drag the image to a blank character cell. 

The image portion you dragged and dropped is
now a character in the clip art library.  

Note that if the character cell is not blank, the im-
age will overwrite the existing character in that
cell.

7. Click on the [Save] button to save your
changes.

Note that the font/clipart library window at the bottom
of the screen closes when you select another trans-
form option or tool.

Tiling an image 

This feature tiles images into fonts automatically with
the options you choose.  Refer to the following figure
when tiling an image into a font.

Figure 5-15.  Tiling options
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To convert an image or image area into a font, using
the tiling feature:

1. Load the image, pull down the Transform
menu and select [Export], or click on the
[Export] option in the Transform toolbox.

2. Click on the [Tile] button.

3. Click on the [Load] button to display the
Create Font dialog box.  Enter a file name in
the box and click on [OK].

Figure 5-16.  Create Font dialog box

A window with a blank set of characters displays
at the bottom of the screen.

4. Select the [Sequence] or [Size] option from
the Toolbox.

Select [Sequence] to specify the number of
rows and columns you want the image tiled
to.

Select [Size] to specify the width and height of
the tiles.
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5. Specify the start position of the first tile in the
font.  The default 65 corresponds to ASCII
upper case A.  

Note that the maximum number of cells in a font
is 255.

6. Place the tiles [Above the baseline] or [Below
the baseline] by selecting the appropriate
option in the Toolbox.

7. Mark the area you want to tile to a font.  

If you are tiling the whole image, skip this step.

8. Click on the [Go] button to tile the whole
image or image area into a font.

The image or image area is tiled into the blank
character cells at the bottom of the screen.

You may need to scroll through the font to display
the first character.

Figure 5-17.  Tiling an image into a font
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9. Click on the [Save] button to save the new
font.

To recreate the image in a new file, follow the proce-
dures for importing clip art (see the "Importing clip art"
section of this chapter), but click on the [Font] button
instead of the [Clip Art Library] button to select the font
you just created.

Creating a font from image portions

This operation is similar to creating a clip art library
except that the font created does not start with a caret
(^).  This operation is useful if you have a scanned im-
age containing characters and you want to digitize
fonts from the characters in the image.

Refer to the following figure when creating a font from
image portions.

Figure 5-18.  Font creation options

You can create a font from image portions and save it
as a new font or add it to an existing font.  
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To create a font from image portions and save it as a
new font:

1. Load the image, pull down the Transform
menu and select [Export], or select the
[Export] option in the Transform toolbox.  

2. Click on the [Font] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.

Figure 5-19.  Choose Target Font File 
dialog box

4. Select [Create new font].

The Create Font dialog box displays.

5. Enter a file name and click on [OK].  

A font window with a blank character set displays
at the bottom of the screen.

6. Mark an area in the image.

7. With the cursor inside the area, hold down the
<Ctrl> key, press the mouse button and drag
the image to a blank character cell.  

8. When the cell is highlighted, release the
mouse button to drop the image into the cell.

9. Click on the [Save] button to save your
changes.

To create a font from image portions and add it to an
existing font:

1. Load the image, pull down the Transform
menu and select [Export], or select the
[Export] option in the Transform toolbox.  
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2. Click on the [Font] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.

Figure 5-20.  Choose Target Font File 
dialog box

4. Click on [Load Existing Font].

The Load Font dialog box displays.

5. Select a file to display its contents in a
window at the bottom of the screen.

6. Mark an area in the image

7. With the cursor in the marked area, hold down
the <Ctrl> key, press the mouse button, and
drag the image to a blank character cell.

The image portion you dragged and dropped is
now a character in the font.

Note that if the character cell is not blank, the im-
age will overwrite the existing character in that
cell.

8. Click on the [Save] button to save your
changes.
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Figure 5-21.  Creating a font from an image
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6.  Additional features

This chapter describes additional features included in
ElixiGraphics. These features are not directly related
to drawing or manipulating images, but are included to
help you use ElixiGraphics.

These additional features are:

ruler display
merging an image into another image
expanding or contracting an image
creating a screen version of an image
create an Elixir form which includes the image
splitting an image.

Ruler 

Clicking on the Digital Ruler in the Toolbar toggles the
ruler display on or off.  You can change the units of
measure in the digital ruler when it is displayed, by
clicking on it with the right mouse button.  The unit of
measure changes to inches, centimeters (CM), milli-
meters (MM), or dots.

The first box (from left to right) displays the position of
the cursor relative to the top left corner of the image
area in horizontal (x) and vertical (y) coordinates.  As
you move the cursor down or to the right, the x and y
coordinates increase in value.  As you move the cur-
sor up or to the left, the x and y coordinates decrease
in value.
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The second box displays the x and y coordinates of a
drawing (such as a line, box, or circle) relative to the
starting point.  As you move the cursor down or to the
right of the starting point, the x and y coordinates dis-
play a positive value.  As you move the cursor up or to
the left of the starting point, the x and y coordinates
display a negative value.

Merging an image into another image

Merging images involves placing an one image inside
another currently loaded image.

To merge an image into a currently loaded image:

1. Select the Transform tool and mark the area
where you want to merge the second image. 

The area is marked with a dotted line.

2. Pull down the Edit menu and select the Set
Paste Mode sub-menu to select a paste mode.

See the "Pasting from the clipboard" section of
the "Manipulating images and image areas" chap-
ter for a description of different paste modes.

3. Pull down the File menu and select [Merge] to
display the Merge Image dialog box.
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Figure 6-1.  Merge Image dialog box

4. Select the image you want to merge into the
currently loaded image.

To select from the list of .BMP images, click on
the down arrow in the window at the bottom of the
dialog box and select [.BMP].

The image is placed in the marked area or in the
upper left-hand corner of the loaded image if no
area is marked.  

5. Save your changes into the current file by
pulling down the File menu and selecting
[Save] (or pressing <Ctrl> + <S>), or save your
changes to a new file by pulling down the File
menu and selecting [Save as] (or pressing
<F7>).

ELIXIGRAPHICS USER GUIDE 6-3



Expanding/contracting an image

To expand or contract an image in any of four direc-
tions, pull down the Image menu and select
[Expand/Contract].  The Expand/Contract dialog box
displays.

Figure 6-2.  Expand/Contract dialog box

In the dialog box there are four boxes (top, bottom,
left, and right) containing a <+> option for expanding
and a <-> option for contracting.  Specify the number
of dots you want the image to expand or contract, to
or from the top, bottom, left, or right of the image.

Creating a screen version

This operation creates a new screen version of an im-
age and allows you to specify different resolutions for
the screen version.  Screen versions are used to dis-
play the image on your monitor and are also used
when you want to display the image in ElixiForm.

To create a new screen version, pull down the Image
menu, select the Extra Operations sub-menu, then
select [Make Screen Version].  A screen version with
the same stem name and a .LW8 extension is created
and saved in the default screen image directory.
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Converting an image to a form template

This operation creates an Elixir form from the
currently-displayed image.  This is useful if the image
contains drawing elements which you want to use as a
template for creating other forms.  

For example, you can scan a form to create a PCX
image, convert the scanned image to Elixir format us-
ing the Elixir Desktop, edit the image using Elixi-
Graphics, then use this option to convert it to an Elixir
format form.  You can then use the form as a template
in ElixiForm to create a new form.

Note that the form file this creates uses much less
disk space than the scanned image.

To use this feature, pull down the Image menu,  se-
lect the Extra Operations sub-menu, then select
[Make Form Template].  A form template with the
same stem name of the graphic image and an .ELX
extension, is created using the Elixir graphic and is
saved to the current ElixiForm default forms directory.

Breakup image

This operation divides the image into horizontal or ver-
tical strips of equal height.  This feature is useful if you
want to break up a large image for easier handling (for
example, to convert to a font or clip art library).

To break up an image:

1. Load the image you want to back up.

2. Pull down the Image menu, select the Extra
Operations sub-menu, then select [Breakup
Image].
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The Breakup Image dialog box displays and al-
lows you to specify the number of horizontal or
vertical strips into which you want to split the im-
age.

           Figure 6-3.  Breakup Image dialog box

3. Enter the number of horizontal and/or vertical
pieces you want the image split into.

When you click on [OK], images are created with
the stem name PIECEnn in your
drive:\ELIXIR\PICS\PRINTER directory where nn
is the number you entered in the dialog box.
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A.  Working with
 highlight colors

This appendix describes how to work with highlight  
colors when creating or editing ElixiGraphics images.

Highlight color image composition

A highlight or two-plane color Elixir image comprises
two separate planes: a black plane and a color plane.
The color plane can be red, blue, or green to match
the toner installed on Xerox HighLight Color printers.
One plane is overlaid on the other to create a single
image.

Within either the black plane or the color plane, you
can create or modify an image using any of the draw-
ing tools described in the "Displaying and drawing an
image" chapter, and the textures described in this
chapter. 

Select the plane you want to work in by using the [FG]
button.  The [FG] button allows you to use the editing
tools to draw (edit) in black, white, or a highlight color
(see the "Editing in black and color planes" section of
this appendix).

You can reverse the planes by pressing the Swap
Color Planes fast key, <Ctrl> + <W>.  This operation
displays all highlight color elements in black, and all
black elements in highlight color.

These and other highlight color-related activities are
explained in this chapter.

FG
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Applying highlight color shading patterns

This section describes how to apply highlight color
shading patterns to an image.

You can only apply a highlight color shading pattern to
a highlight color image.  If you have a black-and-white
image loaded and want to apply a highlight color
shading pattern to it, you must first convert the black-
and-white image to a highlight color image.

Note that if you attempt to apply a highlight color
shading pattern to a black-and-white image, the high-
light color shading pattern is converted to a black-and-
white shading pattern and saved to a temporary disk
file.  You can edit this pattern using the procedures
described in the "Displaying and drawing an image"
chapter.

To convert a black-and-white image to a highlight
color image:

1. Load a black and white image into the work
area.

2. Pull down the Image menu and select
[Attributes].

The Image Attributes dialog box displays.

3. Pull down the [Color System] list, select  
[Highlight Color], and click on [OK].

Your black-and-white image is converted to a
highlight color image.

To apply a highlight color shading pattern to a high-
light color image:

1. Load a highlight color image into the work
area.  

2. Pull down the System menu and select [Usage
Switches].

The Preferences dialog box displays.
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3. Click on the down arrow next to the [Xerox
Catalog Name] option and select a Xerox
catalog: [XEROX] or [XEROX1].

This specifies that the pattern files you want to
use are XEROX or XEROX1 pattern files.  These
pattern files emulate XEROX and XEROX1 cata-
log INK names (RED, GREEN, or BLUE) on
Xerox HighLight Color printers.

If you select XEROX, an X prefix is added to the
corresponding RED, GREEN, or BLUE pattern
name.

If you select XEROX1, an X1 prefix is added to
the corresponding RED, GREEN, or BLUE pat-
tern name. 

4. Click on the Pattern window.

If the Black-and-White Pattern or Full Color Pat-
tern window displays, click on the [High..] button
to display the Pattern window.

Figure A-1.  Highlight Color Pattern menu

This window displays up to 102 shading patterns
which you can apply as floodfill or shading in an
image.  The displayed shading patterns are part
of the currently-loaded pattern file (a file in  
\ELIXIR\DESKTOP\SYSTEM\PATTERNS).

By floodfilling or shading with different patterns,
you can apply highlight color to your image.

The pattern files (XRED or X1RED, XGREEN or
X1GREEN, and XBLUE or X1BLUE) contain
shading patterns that emulate Xerox INKS (RED,
GREEN, and BLUE, respectively) for Xerox High-
Light Color printers.
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5. To select one of the above pattern files, click
on the down arrow in the Highlight Color
Pattern window and select the appropriate
file.

When you position your cursor over a pattern in
the Pattern window a thick border displays
around the pattern and the pattern name is shown
in the Pattern name box.

6. Click on a pattern to make it the current
pattern and display it in the Pattern window.

You can now use the selected pattern with an ap-
propriate drawing tool.

Double-click on the [Close] button to exit the Pat-
tern window.

The [Edit] and [Save] buttons are used to edit pat-
terns (see the "Editing highlight color shading pat-
terns" section of this chapter).

You can also click on the [B&W] button to display
the black-and-white shading patterns described in
the "Displaying and drawing an image" chapter.

Editing highlight color shading patterns

The pattern files that come with ElixiGraphics corre-
spond exactly to the INK files on Xerox HighLight
Color printers.  You can edit shaded patterns for use
in ElixiGraphics and for conversion to .PCX, .TIF and
.BMP format.  However, you cannot use custom pat-
terns in ElixiForm, or when converting and printing,
due to the Xerox pattern file system used with Xerox
HighLight Color printers.

To edit a highlight color shading pattern:

1. Select a pattern from the Highlight Color
Pattern window.

2. Click on [Edit] to display the Pattern Editor
dialog box.
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           Figure A-2.  Pattern Editor dialog box

The Xerox INK name box displays the Xerox INK
name that corresponds to the pattern you
selected.

3. Select the color in which you want to edit:
[Black], [Highlight Color], or [White].

4. Click on the bitmap squares to which you
want to apply the selected color, or click on
[Fill Whole Area] to apply the color to all the
squares in the bitmap.

To undo your changes, click on [Undo All
Changes].

5. Click on [OK] and then click on [Save] in the
Pattern window to display the Save Pattern
Set As dialog box.

Enter a new name to save the whole pattern set
to a new pattern file with a  -CUSTOM suffix.
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Editing in black and highlight color planes

The [FG] button allows you to edit in either the black
or highlight color plane.

To edit (or draw) in the highlight color plane click on
the [FG] button until it displays a highlight color (red,
green, or blue).  The highlight color available is set in
the Image Attributes dialog box [Highlight Color]
option.

To edit (or draw) in the black plane, click on the [FG]
button until it displays in black (to edit in black) or
white (to edit in white).

To switch all elements in one plane to the other plane,
press the Swap Color Planes fast key, <Ctrl> + <W>.

Note that this operation is performed on the entire
image.

Converting a color image to black-and-white

You can convert an Elixir-format color image to black-
and-white by using the [Color System] option in the
Image Attributes dialog box, or by using the CLR2BW
utility.  The CLR2BW utility is copied to the
drive:\ELIXIR directory during [Default] installation or
to the drive specified for your programs directory dur-
ing [Custom] installation.

Note the following when converting color images to
black-and-white:

Using the [Color System] option or the CLR2BW
utility when converting highlight color graphics to
one-plane black-and-white graphics converts col-
ors to black.

Using the [Color System] option or the CLR2BW
utility when converting highlight color to black-
and-white, permanently erases any color
information.

FG
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You can run the CLR2BW utility from the Elixir
Desktop using the Dispatcher icon.  See the Elixi-
Sys Desktop User Guide for more information
about the Dispatcher icon.  

Using the [Color System] option

You can use the [Color System] option in the Image
Attributes dialog box to convert Elixir-format .LP3
graphic files between one-plane (black-and-white) and
two-plane (highlight color) formats.

To convert a loaded image from one format to
another:

1. Pull down the Image menu and select
[Attributes].

The Image Attributes dialog box displays.

2. Pull down the Color System list, select the
type of image you want to convert to,
[Black-and-White] or [Highlight Color], and
click on [OK].

Your image is automatically converted to the
specified format.

Using the CLR2BW utility 

The CLR2BW utility converts Elixir-format .LP3 graph-
ics files between one-plane (black-and-white), two-
plane (highlight color), and four-plane (full-color)
formats.

The syntax for this utility is as follows:

CLR2BW [inputname] [outputname]
[planes] [color]<Enter>

inputname
is any .LP3 file stemname. No extensions or wildcards
are allowed.
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outputname
is the optional output stemname for the converted file.
Extensions and wildcards are not allowed. If not speci-
fied, the existing file is converted.

planes
Specify [1] for one-plane (black-and-white) output, [2]
for two-plane (highlight color) output or [3] for full-color
output.

color
Specify [RED], [BLUE], or [GREEN].  When convert-
ing full-color to highlight color, any color with the com-
ponent you specify is converted to the pure highlight
color.  For example, if you specify RED, yellows
(which include red) in a full-color graphic are con-
verted to red.  Other colors are converted to black.

Run the CLR2BW utility from the drive:\ELIXIR direc-
tory (if you performed a [Default] install) or the drive
you specified for programs (if you performed a [Cus-
tom] install).  
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B.  Keyboard shortcuts

The following keyboard shortcuts (fast keys) are avail-
able within ElixiGraphics.  Standard Windows fast
keys are not included in the list.  For information about
Windows fast keys, see your Windows
documentation.

Numeric display box and transform "on the fly" fast
keys are listed separately at the end of this appendix.

Command Action

Close dialog 
box/menu <Esc>

Copy <Ctrl> + <C>

Cut <Ctrl> + <X>

Delete <Del>

Exit <Alt> + <X> or <Alt> + <F4>

Help <F1>

Image attributes <F2>

Load <F8>

New (file) <F9>

Paste <Ctrl> + <V>

Print <Ctrl> + <Shift> + <F10>

Redo <Shift> + <Ctrl> + <Z>

Save <Ctrl> + <S>

Save as <F7>
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Select All (toggle) <Ctrl> + <A>

Switch Color Planes <Ctrl> + <W>
(highlight color only)

System information <Alt> + <F5>

Toolbox display 
(toggle) <F10>

Undo <Ctrl> + <Z>

Unselect (toggle) <Ctrl> + <A>

The following fast keys are used for editing numbers
in numeric display boxes  (such as the [Tool Width]
option).  Numbers are entered from right to left, similar
to a pocket calculator.  For all but the "Select
highest/lowest allowable value" fast keys, you must
first activate edit mode by clicking in the display box.

Delete number 
(set to 0) <Del>

Delete right digit <Bksp>

Edit (toggle) Left click

Finish editing <Enter>

Reset and finish 
editing <Esc>

Set highest 
allowable value<Shift> - click

Set lowest 
allowable value<Ctrl> - click

Undo edits and reset 
to initial <Ctrl> + <Z>

The following fast keys are used for transforming im-
ages or image areas.  All except the Resize, Clear,
and Shift transformations can be applied "on the fly"
during move or copy operations.

Clear <Ctrl> + <E>

KEYBOARD SHORTCUTS
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Darken <Ctrl> + <K>

Distort <Ctrl> + <D>

Filter <Ctrl> + <F>

Halftone <Ctrl> + <H>

Lighten <Ctrl> + <T>

Mirror <Ctrl> + <M>

Outline <Ctrl> + <L>

Resize <Ctrl> + <R>

Reverse <Ctrl> + <B>

Rotate <Ctrl> + <O>

Shift <Ctrl> + <I>

KEYBOARD SHORTCUTS
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C. DOS directories

Elixir software is directory-specific.  The following is a
list and description of default DOS directories used by
Elixir software for graphics-based operations.   Note
that the drive is the drive where you installed
ElixiGraphics.

\ELIXIR\PICS\PRINTER
Elixir-format .LP3 images (input and output)

\ELIXIR\PICS\IMCIN
Input Xerox color .IMG files

\ELIXIR\PICS\IMCOUT
Output Xerox color .IMG files

\ELIXIR\PICS\IMGIN
Input Xerox .IMG files

\ELIXIR\PICS\IMGOUT
Output Xerox .IMG files

\ELIXIR\PICS\LGCIN
Input Xerox color .LGO files

\ELIXIR\PICS\LGCOUT
Output Xerox color .LGO files

\ELIXIR\PICS\LGOIN
Input Xerox .LGO files

\ELIXIR\PICS\LGOOUT
Output Xerox .IMG files

\ELIXIR\PICS\PCXIN
Input .PCX files

\ELIXIR\PICS\PCXOUT
Output .PCX files
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\ELIXIR\PICS\SCREEN
Screen versions of Elixir images (.LW8)

\ELIXIR\FORMS\ELIXIR\ and subordinate directories
Elixir format forms (.ELX).  (Note that the default di-
rectory is set in ElixiForm software.)

\ELIXIR\PICS\TIFFIN
Input TIFF (.TIF) images

\ELIXIR\PICS\TIFFOUT
Output TIFF (.TIF) images

\ELIXIR\FONTS\ELIXIR
Elixir-format fonts and clip art libraries

\ELIXIR\PICS\BMPIN
Input bitmap (.BMP) images

\ELIXIR\PICS\BMPOUT
Output bitmap (.BMP) images  

DOS DIRECTORIES
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D. Conversion chart

You can convert graphics created in ElixiGraphics to
different formats using the ElixiSys Desktop.  The fol-
lowing chart shows the supported conversions.

ELIXIR

to

Screen

to

PCX

to

TIFF

to

BMP

to

IMG

to

LGO

to

Color

IMG

to

TILE

to

Color

LGO

to

ELIXIR --- X X X X X X X

Screen X --- X X X

PCX X --- X X X

TIFF X --- X X X

BMP X --- X X

TILE X X ---

IMG X X ---

LGO X X ---

Color

IMG

X X ---

Color

LGO

X X ---
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 Glossary

baseline
An imaginary line which is used to position a charac-
ter.  Characters may rest on the baseline or extend
above or below it.  Characters are normally positioned
so that their baselines are aligned.  Such characters
are said to be base aligned. 

bitmap
A two-dimensional array of dots which is used to rep-
resent an image.

blend text mode
The mode during text entry in which text entered
through the Enter New Text dialog box displays in the
Work area, and is editable because text entry mode is
still active.  After text entry mode ends, the text be-
comes a permanent part of the image, and cannot be
edited using the keyboard.

cell
An invisible frame surrounding a character whose
width equals the set width and whose height equals
the line spacing of the font.

face name
A unique design for printed letters, such as Press
Roman.

fixed-pitch
The characteristic of a font family whose characters
are all assigned the same horizontal spacing.

font
A complete set of characters of a particular font fam-
ily, size, face name, and orientation.  A font can also
consist of tiles that compose an image, or pieces of
clip art.
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font family
A set of fonts with similar design characteristics, usu-
ally including many sizes, typefaces, and orientations.

halftoning
The application of line or shading patterns to an image
so it appears textured.

Inverse landscape/portrait orientation
Refers to the print direction of images or fonts as
shown in the following figure.

       Figure G-1.  Page and print orientations

mirroring
The rotation of an image so that its top becomes its
bottom or its right becomes its left.

null character
An unprintable character that occupies an unused po-
sition in a font.

pitch
The size (specifically the width) of a fixed-pitch font in
characters per inch.

pixel
The smallest unit of a digitized picture, either on the
screen or printed.  A pixel is sometimes referred to as
a dot.  Image bitmaps are made up of dots or pixels.
The word pixel is a contraction of "picture element".  A
pixel can contain additional information such as color
and can be larger than one bit while still representing
one dot.
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 proportional spacing
The characteristic of a font family, each character of
which is assigned its own horizontal spacing.  Propor-
tional space fonts are aesthetically more pleasing and
are easier to read.  The text in this guide is proportion-
ally spaced.

reverse
To switch an image from black on a white background
to white on a black background, or vice versa.

strikeout
To place a line horizontally across a font.

underline
To place a line under text, usually for emphasis (also
called underscore).

GLOSSARY
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A
airbrush, 3-21
area

clear, 4-10
copying, 4-2, 4-4
darken, 4-15
distort, 4-9
filter, 4-18
halftone, 4-13
lighten, 4-16
mirror, 4-8
move, 4-3
outline, 4-14
resize, 4-5
reverse, 4-11
rotate, 4-6
saving, 4-4
shift, 4-12
transforming, 4-4

autogenerating output
name, 2-21

B
background, 2-6, 3-5
BG button, 2-6, 3-5
bitmapped graphics, 2-1
black and white, 2-15
blend text mode, 5-3
BMP, 2-1
border style, 3-7
border width, 3-6
box, 3-12
brush, 3-19

C
circle, 3-14
clear, 4-10
clip art, 3-26, 5-10

creating, 5-14
importing, 5-11

clipboard operations,
4-19
CLR2BW utility, A-7
color mode, 3-2
color system, 2-15
conventions

display, 1-3
typographical, 1-3

conversion chart, D-1
converting an image to a
font, 5-13

clip art, 5-13
font, 5-13

copying
area, 4-2
Copy Screen Area,
4-20
multiple, 4-4
single, 4-4
whole image, 4-2

creating a font from im-
age portions, 5-20
creating an image, 2-17
curve, 3-10
custom palettes, A-5
customer support, 1-1

D
darken, 4-15
default directories, C-1
digital ruler, 2-7, 6-1
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directories, C-1
displaying an image, 3-1
distort, 4-9
DOS directories, C-1
drawing modes, 2-8,
3-27, 5-9
drawing patterns, 3-28
drawing tools, 2-5, 3-5

airbrush, 3-21
border, 3-7
box, 3-13
brush, 3-19
color, 3-5
curve, 3-10
ellipse/circle, 3-14
eraser/replacer,
3-25
floodfill, 3-22
line, 3-7
pencil, 3-18
polyline/polygon,
3-16
text/clip art, 3-26
width, 3-6

E
Edit menu, 2-4
editing

highlight color pat-
terns, A-4

editing an image, 2-16
editing text, 5-3
ElixiFont, 2-2
ElixiForm, 2-2
Elixir environment

ElixiFont, 1-3
ElixiForm, 1-2

Elixir font selector, 2-9,
5-4
ellipse, 3-14
entering text, 5-1
eraser, 3-25
exiting ElixiGraphics, 1-8
expanding/contracting
image, 6-4

F
fast keys, B-1
features, 2-3

ElixiGraphics menu
bar, 2-4
message area, 2-8
toolbar, 2-7
toolbox, 2-5
Work Area menu
bar, 2-4

FG button, 2-6, 3-5
File menu, 2-4
filter, 4-18
floodfill, 3-22
font selector, 2-9
fonts

baseline rotation,
5-7
boundaries, 5-6
Elixir, 5-4, 5-5
inter-character spac-
ing, 5-9
justification, 5-7
positioning, 5-7
selection, 5-8
windows, 5-4
wrap, 5-9

foreground, 2-6, 3-5
form template, 6-5
formats, D-1
full-color graphics, 2-15

G
Go button, 2-6, 3-6, 4-4
grid, 2-8, 3-3

color, 2-11

H
halftone, 4-13
help, 1-4
Help menu, 2-4
HighLight-color graph-
ics, 2-15

INDEX

INDEX-2 ELIXIGRAPHICS USER GUIDE



highlight color image
composition, A-1
converting to B&W,
A-6
editing, A-6

hypergraphics, 1-5

I
image

create form tem-
plate, 6-5
creating, 2-17
displaying, 3-1
displaying attributes,
2-15
editing, 2-16
expand/contract, 6-4
loading, 2-12
printing, 2-19
reseting, 2-19
saving, 2-16
screen version, 6-4
splitting, 6-5

image attributes, 2-15,
2-17
Image menu, 2-5
IMG, 2-1
introduction, 1-1

K
keyboard mapping, 2-10
keyboard shortcuts, B-1

L
LGO, 2-1
lighten, 4-16
line, 3-7
load an image, 2-12, 3-1

M
magnification, 2-7, 3-2
marking an area, 4-2
menu bar, 2-4

merging an image, 6-2
mirror, 4-8
moving

area, 4-2
whole image, 4-2

moving an area, 4-3

O
on-line help, 1-4
outline, 4-14
overview, 2-1

P
page shift, 2-20
paste modes, 4-20
pattern button, 2-6
patterns

black-and-white,
3-6, 3-28
editing, 3-29
full color, 3-6, 3-28
highlight color, 3-6,
3-28

PCX, 2-1
pencil, 3-18
polyline, 3-16
print preview, 3-4
printer resolution, 2-20
printing an image, 2-19
printing to file, 2-21

R
redo, 2-8
reduction, 2-7, 3-4
refreshing the screen,
2-19
replacer, 3-25
reset, 2-12, 2-19
resize, 4-5
reverse, 4-11
rotate, 4-6
ruler, 2-7, 6-1

INDEX

ELIXIGRAPHICS USER GUIDE INDEX-3



S
saving

areas, 4-4
images, 2-16

saving an image, 2-16
saving configuration,
2-12
scanning graphics, 2-2
screen version, creating,
6-4
select all, 4-4
setting up, 2-9
shift, 4-12
soft keyboard, 5-3, 5-8
splitting an image, 6-5
starting ElixiGraphics,
1-7
support, customer, 1-1
system information, 2-12
System menu, 2-4

T
text, 3-26

displaying Elixir
fonts, 5-6
entry, 5-1
properties, 5-4

text toolbox, 5-2
TIFF, 2-1
tiling an image into a
font, 5-17
Tool menu, 2-5
toolbar, 2-7
toolbox, 2-5
transform, 3-27

area, 4-1, 4-4
tool, 4-1
whole image, 4-1,
4-4

Transform menu, 2-5
transform operations

clear, 4-10
darken, 4-15
distort, 4-9

export, 5-14, 5-18,
5-21
filter, 4-18
halftone, 4-13
import, 5-11
lighten, 4-16
mirror, 4-8
outline, 4-14
resize, 4-5
reverse, 4-11
rotate, 4-6
shift, 4-12

U
undo, 2-8, 2-10
unselect, 4-4
usage switches, 2-9
using ElixiGraphics, 2-8

V
vector graphics, 2-1
views

magnified, 3-2
reduced/print size,
3-4

W
Window menu, 2-4
work area, 2-3
work area menu bar, 2-3
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